
Windows Servo Design Kit 

WSDK 

 
 
 
 
 
 

 
 

Galil Motion Control 
 
 



 



Windows Servo Design Kit WSDK Contents  ••   i 

Contents 

Chapter 1 - Overview 1 

Chapter 2 - Getting Started 2 

Software Installation.................................................................................................................2 
Running WSDK.........................................................................................................................2 
Registering the Controller and Setting Up Communications..............................................3 

Chapter 3 - Tuning Methods 7 

Chapter 4 - Storage Scopes 11 

Chapter 5 - System Evaluation 14 

Evaluation of System Performance.......................................................................................14 

Chapter 6 - System Evaluation Options 16 

Chapter 7 - System Information 18 

Chapter 8 - Terminal and Program Editor 21 

Program Editor.........................................................................................................................21 

Glossary of Terms 23 

Index 25 

 





Windows Servo Design Kit WSDK Chapter 1 - Overview  ••   1 

Chapter 1 - Overview 

The Windows Servo Design Kit software has been designed to help the user setup and analyze your motion controller.  
Windows Servo Design Kit will walk you through set-up and configuration, tuning, testing, and analysis. 
 
The Windows Servo Design Kit software was designed for use with the following Galil Motion Controllers: DMC-1000 
series, DMC-1400 series, DMC-1500 series, and DMC-1700 series.  There are two versions of the Windows Servo Design 
Kit.  WSDK16 has been designed for use with the operating systems, Windows 3.1 and Windows 3.11.  WSDK32 has 
been designed for use with the operating systems, Windows 95 and Windows NT. 
 
WSDK (Windows Servo Design Kit) has a number of functions that simplify the task of setting up a complete servo 
system.  Each step of the servo system assembly process is addressed: 
 

• Setting up communications 
• Connecting the system components  
• Automatic tuning of the servo motors 
• Evaluation of the systems performance 
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Chapter 2 - Getting Started 

Software Installation 
This software must be installed under Windows.  From the Program Manager select the ‘File’ menu then the ‘Run’ option.  

\setup” to install the software from the b: floppy drive.  WSDK will be installed and a program group created with 
the WSDK icon. 
 

Note: If you are running Windows 3.1, Windows 3.11, or Windows for Workgroups 3.11 you should be 
installing the 16-bit version of WSDK or WSDK16.  If you are running Windows 95 or Windows NT, 
you should be installing the 32-bit version of WSDK or WSDK32. 

 

Running WSDK 
Double click on the WSDK icon created during the installation process.  The main window will appear.  Use this window 
as a starting point to all the functions within WSDK.  Refer to this picture in the following descriptions: 
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Registering the Controller and Setting Up 
Communications 

If you have not already registered your controller with Windows, you must do so before you can communicate with it.  
The menu item File | Register Controller (located on the main form only) will allow you to register your controller.   
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In order to communicate with your Galil controller, you must first register it in the Windows registry.  The Windows 
registry is a central repository of information concerning all hardware installed on your system.  To register your 
controller, select the “Getting Started” button on the main window, then from the Getting S
Galil Controller” button.  When you click the “Add” button on the Edit Galil Registry window, the follow window will 
appear: 
 
 
All configuration information pertaining to your motion controller is stored in the Windows registry.  Once registered, the 
Servo Design Kit program can then communicate with the controller.  To register your controller, first select the model of 
your controller.  Then, select the relevant parameters for the type of controller you have.  You only need to register your 
controller one time as the information is stored in permanent memory. 
 
You may need to close the Servo Design Kit program and re-boot your system in order for the changes to the 
configuration to be recognized by the system. 
 



Windows Servo Design Kit WSDK Chapter 2 - Getting Started  ••   5 

 
The first action is to select the model of Galil motion controller installed.  Once you have selected a model, you must then 
enter the appropriate parameters for that controller.  For example, for a DMC-1000, you must select an I/O port address 
and optionally an interrupt (IRQ).  For a DMC-1500, you must select the comm port and comm speed. 
 

Note: Hardware handshake should always be enabled for the DMC-1500.  Make sure the handshake 
parameter is set to hardware on this screen as well as the dip switch setting on the DMC-1500. 

 
Unless otherwise instructed by Galil, leave the Timeout and Delay parameters set to their default values. 
 
Once you have entered all the necessary parameters, click the “OK” button to register your controller. 
 
 
Connect to Controller 
 
The menu item File | Connect to Controller will allow you to open a communications session with your controller. 
 
 
Once you have registered your controller in the Windows registry, you may communicate with it..  If you have more than 
one controller registered, the Servo Design Kit program will display a window from which you may select a controller.  
Highlight the controller in the list box you wish to connect to with the mouse or keyboard, then click the OK button.  You 
may also double-click on the controller in the list box. 
 
Once your controller has been registered, you  may communicate with it by selecting the “Communicate with Galil 
Controller” option on the Getting Started window. 
 

Note: You may have to reboot your Windows system in order for the system to recognize changes made 
to the Windows registry.  If you are unable to communicate with your controller after registering it, 
reboot your system. 

 
If you have more than one Galil controller registered in the Windows registry, you will be prompted for the controller to 
communicate with. 
 



6  ••   Chapter 2 - Getting Started Windows Servo Design Kit WSDK 

 
Once you have registered your controller and are connected with it, the following options are available from the main 
form: 
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Chapter 3 - Tuning Methods 

From the main screen select the “Tuning” button.  There are a number of tuning routines available; at least one will 
provide adequate tuning parameters.  If one type of tuning does not provide acceptable performance try another one.  If 
any routine provides suitable values there is no need to continue with further auto-tuning routines.  
 

Note: Most routines will produce tuning parameters that are not optimal.  Some manual adjustments 
may be required to create desired results. 

 
Listed below are the routines currently offered in WSDK: 

• General Tuning:  This routine will work for systems with various types of drives and amplifiers.  This 
routine tunes the system by increasing the gain until instability occurs , then backs the gain down. 

• Conservative Tuning:  This routine tunes the system by increasing the gain until instability occurs , then 
backs the gain down.  As the name suggests, the resulting parameters are very conservative but will provide 
an operational system.   

• Manual Tuning: Unlike the other tuning methods, this is not an auto-tuning routine.  All tuning parameters 
can be adjusted with the sliders.  Whenever the values are changed they are sent to the controller giving 
instant feedback as to the effect those changes made to the stability of the system.  

 
 

• Crossover Frequency: This routine produces PID parameter values that will provide the best system 
response at the frequency ( in rads/s ) specified.  The crossover frequency value should be set to the 
bandwidth of the system for best results.  

• Automatic Crossover Frequency: Uses the same basic tuning routines as the standard crossover but will try 
a number of frequencies and select the one that gives the best system response.  Use this routine if the 
bandwidth of the system is unknown. 

 
 
Tuning Methods  
 
This form allows you to choose from one of five tuning routines by clicking on the Tuning Method combo box.  The 
Crossover Frequency routine will let you define a crossover frequency, and then attempt to tune the axis.  The Auto 
Crossover Frequency routine attempts to find the 'best' crossover frequency, and then tune the axis.  The General Tuning 
routine is best suited for velocity mode amplifiers, although it will work with most any type of system.  It is more 
'aggressive' than the Conservative Compensation routine.  The Conservative Compensation routine will try to find a gain 
setting that won't cause 'buzzing' or overdrive your system.  The Manual Method will let you choose the gain and 
damping on your system..  You can tune any axis on your system by clicking on the Axis combo box. 
 
 
For each of the tuning methods, you may optionally display a step response based on the current PID filter settings.  The 
step response provides a visual indication of how well your system is tuned. 
 
Tuning Methods  
 
Auto Crossover Frequency 
Crossover Frequency 
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General Tuning 
Conservative Compensation 
Manual Method 
 
 
Parameters 

 
Auto Crossover Frequency Tuning 
 
This test will try to tune your system for a crossover frequency that the software judges as best. 
 
Parameters 
 
Crossover Frequency Tuning Parameters 
 

Crossover Frequency Tuning Parameters 
 
This window is where you can select the auto-crossover frequency and crossover frequency tuning parameters..  Both of 
these tests start by sending a pulse or offset to the axis at a specified voltage and duration.  You can change the values 
for Pulse Magnitude in volts and Pulse Duration in milliseconds.  You can either type in new values or use the sliders to 
change the values.  When you are done, click the OK  button to return you to the previous screen.  If you wish to save 
these values permanently, click the Save button.  If you wish to restore the values to their defaults, click the Defaults 
button.  If you don't want to keep the changes you made, click the Cancel button. 
 
Crossover Frequency Tuning 
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This test will try to tune your system for a crossover frequency that you specify.  You can choose a frequency between 5 
and 650 rads/sec..  The lower the frequency, the slower and more sluggish the response of your system.  The higher the 
frequency, the faster and more responsive your system will be.  The problem with lower frequencies is that your system 
tends to be over-damped and sluggish.  The problem with higher frequencies is that your system tends to be under-
damped and produces overshoots. 
 
Parameters 
 
Crossover Frequency Tuning Parameters 
 
 

Crossover Frequency Tuning Parameters 
 
This window is where you can select the auto-crossover frequency and crossover frequency tuning parameters..  Both of 
these tests start by sending a pulse or offset to the axis at a specified voltage and duration.  You can change the values 
for Pulse Magnitude in volts and Pulse Duration in milliseconds.  You can either type in new values or use the sliders to 
change the values.  When you are done, click the OK  button to return you to the previous screen.  If you wish to save 
these values permanently, click the Save button.  If you wish to restore the values to their defaults, click the Defaults 
button.  If you don't want to keep the changes you made, click the Cancel button. 
 
 
General Tuning 
 
This test is called general tuning because it will work for systems with various  types of drives and amplifiers.  In this test, 
the system attempts to find the best value for KP while holding KD constant.  Once the best KP is found for a given KD, 
KD is increased and the test continues.  Eventually, KD can not be increased any further without causing instability and 
it is backed down.  Then the final values for KD and KP are set.  As a last step, the test finds the best value for KI. 
 
Conservative Compensation Tuning 
 
This is a two-part test.  The first part is a "static" test, and the second part is a "dynamic" test.  In the static test, the 
system gain is increased, while being excited with a small impulse.  Once the system looses stability, the gain is backed 
down and the results are shown.  In the dynamic test, the system gain is increased while movement is occurring.  Once 
the system looses stability, the movement is stopped, and the gain is backed down. 
 
Manual Method Tuning 
 
Manual tuning provides a means of testing the responsiveness of your system.  This tuning method uses the step 
response , which is displayed on the window, as a means of showing changes made to the PID filter.  You can change the 
system gain and damping by clicking on the sliders or by typing in new values in the appropriate box.  You can change 
the step response parameters by clicking on the Step Response Parameters menu item.  To try out new values for KP, KD, 
and KI, click on the Start Test button. 
 
 
Step Response Parameters 
 
This window is where you can change the values used for displaying the step response.  You can change any of the 
following items:  Dwell Time, Step Size, Acceleration, Deceleration, and Maximum Speed, as well as some display options.  
You can either type in new values or use the sliders to change the values.  When you are done, click the OK  button to 
return you to the previous screen.  If you wish to save these values permanently, click the Save button.  If you wish to 
restore the values to their defaults, click the Defaults button.  If you don't want to keep the changes you made, click the 
Cancel button. 
 
Set-up and Configuration 
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The Set Up and Configuration form is intended to be used to display and/or edit the set up parameters for your motion 
controller.  The set up parameters are those variables which are saved in the non-volatile memory (EEPROM) of the 
controller when the burn (BN) command is executed.  The following menu items are available.  
 

 
Servo Design Kit Options 
 
Tuning Methods 
Storage Scopes 
System Evalutation 
System Information 
Set-up and Configuration 
 
Each of the Servo Design Kit options will display a different form.  The available menu items will vary from one form to the 
next.  Every form  has  a Terminal menu item from which you may communicate directly with the controller.  Every form 
also has an Exit menu item ,which when clicked, will return you to the main form. 
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Chapter 4 - Storage Scopes 

 
This form provides several emulation s of a storage scope.  A storage scope can record the actions of your controller and 
display them on the screen.  To record the controller's actions, you must first select what type of data you want to record.  
This is done with the various combo-boxes.  It is also possible to display a derivative of the data you have recorded.  For 
example, if you want to see velocity, you could select Actual Position as the data type and then select Derivative.  It 
defaults to Normal.  If you wish, you can save or print the storage scope data. 
 
 
You may customize the appearance of the storage scope in various ways:  turning grid lines on or off, showing or not 
showing data values, showing minimum and maximum values, and changing Data Colors. 
 
To switch between storage scope options, click on the desired tab at the top of the screen just below the menu bar. 
 
Storage Scope Options 
 
Single Scope 
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Multiple Scopes 
Continuous Scope 
Scope Zoom 
 
Storage Scope Parameters 
 
Storage Scope Parameters 
 
Storage Scope Data Colors 
 
This window allows you to change the color of any of the four scope traces.  The only time you will see four traces at the 
same time will be in the Storage Scope with 4 windows.  Most of the time, you will see 1 or maybe 2 traces.  Be sure to set 
the trace colors to something that will be easy to see. 
 
Storage Scope (Single Scope) 
 
This screen provides a single storage scope which is able to display two traces.  To record the controller's actions, you 
must first select what type of data you want to record.  This is done with the combo-boxes. The data type defaults to 
Actual Position.  If you want to record two axes in coordinated motion, select which two axes to record.  The axis 
selection combo-box is near the upper right corner.  It defaults to X Axis Vs. Time. 
 
It is also possible to display a derivative of the data you have recorded.  For example, if you want to see velocity, you 
could select Actual Position as the data type and then select Derivative.  It defaults to Normal. 
 
If you want to have two traces on the screen, select Collecting for Secondary, then select the axis and data type.  When 
you have set up all the collecting combo-boxes, make sure the Command String has the correct starting command for the 
program loaded in the controller.  Click the Start Collecting button to get the data into the scope. 
 
Storage Scope (Multiple Scopes) 
 
These screens provide two, three, or four storage scopes.  To record the controller's actions, you must first select what 
type of data you want to record.  This is done with the combo-boxes. The data type defaults to Actual Position.  Each 
scope is capable of recording and displaying a different type of data. 
 
It is also possible to display a derivative of the data you have recorded.  If you wanted to see velocity, you could select 
Actual Position as the data type and then select Derivative.  It defaults to Normal. 
 
Storage Scope (Continuous) 
 
This screen provides a continuous storage scope.  Although not quite real-time, the continuous storage scope does 
provide continuous recording and displaying of data.  On slower systems, the scope period may have to be set higher 
than 4 milliseconds or else data points may be lost. 
 
To record the controller's actions, you must first select what type of data you want to record.  This is done with the 
combo-boxes.  The data type defaults to Actual Position. 
 
It is also possible to display a derivative of the data you have recorded.  For example, if you want to see velocity, you 
could select Actual Position as the data type and then select Derivative.  It defaults to Normal. 
 
The minimum and maximum values to display on the graph can be adjusted at any time (even when the scope is active) by 
typing in new values or by using the spin buttons. 
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A trigger may be set by clicking on the Trigger On check box and adjusting the minimum and maximum trigger values.  
The continuous storage scope will stop whenever a recorded value is less than or equal to the minimum trigger value or 
greater than or equal to the maximum trigger value.  When the continuous storage scope stops due to a trigger condition, 
the trigger value is high-lighted by means of a vertical line on the graph. 
 
Storage Scope Zoom 
 
This form allows you zoom-in on a portion of the storage scope graph.  As you move the mouse over the graph, you will 
notice that the actual X and Y coordinates are tracked and displayed above the graph.  To zoom in on a portion of the 
graph, hold down the left mouse button and drag the mouse.  As you drag the mouse, you will notice a rectangular area 
will form (denoted by a dotted line).  The area inside this rectangle will be expanded to the size of the entire graph when 
you release the left mouse button.  To zoom out from a position, click the Zoom Out button.  To restore the graph to its 
original perspective, click the Fit Data button. 
 
Storage Scope Parameters 
 
This window is where you can change the values used for generating the storage scopes.  You can change the number of 
data points collected and the period between collection points.  You can either type in new values or use the sliders to 
change the values.  When you are done, click the OK  button to return you to the previous screen.  If you wish to save 
these values permanently, click the Save button.  If you wish to restore the values to their defaults, click the Defaults 
button.  If you don't want to keep the changes you made, click the Cancel button. 
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Chapter 5 - System Evaluation 

Evaluation of System Performance 
Once the tuning is complete the system should be ready for operation.  Checking the response characteristics of the 
system can be done in two ways; use the autographing feature contained in each tuning procedure, or use the storage 
scope functions to design a custom test. 
 
Storage scopes can be used to graph data from the card to the PC screen.  Data can be presented versus time or some 
other axis.  To use the scopes follow these simple steps: 
 

• Select “Storage Scope” from the main screen 
• Select the number of scopes to display 
• From the lists provided, set the data to be displayed 
  

  
  
• Bring up the terminal ( under the File menu )  
• From the terminal type in a single move or entire program ( see using the Terminal, below ) 
• Return to the storage scope and type in the command string.  This string is sent at the same time data 

collection begins, making sure data collection is synchronized to the start of the motion.  
• Select the “Start Collecting” button the gather and display the information 

 
Other features of the scope under the ‘Collection’ menu include: 
 

• Number of Sample Points: Increase this value to see more data on the graph 
• Sample Period: Sets the period between consecutive data points 

 
 
You have four types of system evaluations that you can perform.  The Absolute Stability test is a good place to start.  
Follow that with the Step Response test (accessible from the Tuning Methods form).  Then you can try the frequency 
response on either the open-loop or closed loop response.  The Absolute Stability test will make sure you have 
connected all the wires in your system properly.  It does not check for gain/damping problems.  The Step Response test 
attempts to find out the gain of your system.  It will also point out any errors in your gain/damping.  The Frequency 
Response (closed and open-loop) will give you a graphical look at the responsiveness of your system. 
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The Step Response test can be found on the Tuning Methods form.  To perform a Step Response test without changing 
the tuning parameters of your system, make sure the Perform Tuning Test check box is unchecked. 
 
To switch between System Evaluation options. click on the desired tab located at the top of the screen just below the 
menu bar. 
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System Evaluation Options 
 
Absolute Stability 
Step Response 
Closed-loop Frequency Response 
Open-loop Frequency Response 
 
Absolute Stability Test 
 
This test will subject your system to an impulse response.  The impulse response tends to saturate your system, and will 
be a good indicator of whether or not your system is truly stable.  You can change the parameters of the test by clicking 
on the Edit | Absolute Stability Test Parameters menu item. 
 
Parameters 
 
Absolute Stability Test Parameters 
 
This window is where you can  change the parameters used by the Absolute Stability test.  You can change the Pulse Size 
and the Pulse Time (duration).  You can either type in new values or use the sliders to change the values.  When you are 
done, click the OK  button to return you to the previous screen.  If you wish to save these values permanently, click the 
Save button.  If you wish to restore the values to their defaults, click the Defaults button.  If you don't want to keep the 
changes you made, click the Cancel button. 
 
Frequency Response on Closed-Loop 
 
This test will perform an analysis of the closed-loop frequency response of your system.  As the test is in progress, the 
last frequency and response amplitude is displayed in the upper right box.  You can select which axis to test by clicking 
on the Axis combo box.  You can change the starting and ending frequency by clicking the Edit | Frequency Response 
Parameter menu item.. 
 
Parameters 
 
Closed-Loop Frequency Parameters 
 
Frequency Response Parameters 
 
This window is where you can  change the parameters used by the Frequency Response tests.  You can change the 
Starting Frequency, Ending Frequency, Amplitude, and Frequency Step.  You can either type in new values or use the 
sliders to change the values.  When you are done, click the OK  button to return you to the previous screen.  If you wish 
to save these values permanently, click the Save button.  If you wish to restore the values to their defaults, click the 
Defaults button.  If you don't want to keep the changes you made, click the Cancel button. 
 
Frequency Response on Open-Loop 
 
This test will perform an analysis of the open-loop frequency response of your system.  As the test is in progress, the last 
frequency and response amplitude is displayed in the upper right box. You can select which axis to test by clicking on the 
Axis combo box.  You can change the starting and ending frequency by clicking the Edit | Frequency Response Parameter 
menu item.. 
 
Parameters 
 
Open Loop Frequency Parameters 
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Frequency Response Parameters 
 
This window is where you can  change the parameters used by the Frequency Response tests.  You can change the 
Starting Frequency, Ending Frequency, Amplitude, and Frequency Step.  You can either type in new values or use the 
sliders to change the values.  When you are done, click the OK  button to return you to the previous screen.  If you wish 
to save these values permanently, click the Save button.  If you wish to restore the values to their defaults, click the 
Defaults button.  If you don't want to keep the changes you made, click the Cancel button. 
 

Chapter 6 - System Setup 
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Chapter 7 - System Information 

 
This form displays controller status information such as current position, error, and state of the inputs and outputs.  The 
information is organized by Axis information and General information.  Click the tab on located at the top of the screen 
just below the menu bar to switch between. 

 
To update the information displayed, click the Edit | Refresh Display menu item.  To update the information continuously 
(approximately every 100 milliseconds), click the Edit | Continuous Refresh menu item (the menu item will appear checked).  
To stop the continuous display, click the Edit | Continuous Refresh menu item again (the menu item will appear 
unchecked). 
 
System Information Parameters 
 
This window is where you can  change the parameters used by the System Information form.  You can change the Refresh 
Rate used by the Continuous Refresh menu item.  You can either type in new values or use the sliders to change the 
values.  When you are done, click the OK  button to return you to the previous screen.  If you wish to save these values 
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permanently, click the Save button.  If you wish to restore the values to their defaults, click the Defaults button.  If you 
don't want to keep the changes you made, click the Cancel button. 
 
Menu Items  
 
 File 
      Open Parameters 
      Save Parameters 
      Save Parameters As 
      Create DMC File 
      Print 
      Exit 
 Edit 
      Get Parameters 
      Set Parameters 
      Clear Values 
      Reset Controller 
      Master Reset Controller 
 
Open Parameters 
 
This command will allow you open a previously saved parameter file.  Parameter files have the extension .BRN. 
 
Save Parameters 
 
This command will save the set up parameters to the current parameters file.  The current parameters file is set by the 
Open Parameters command.  If no current parameters file exists, you will be prompted to supply a file name.  Parameter 
files have the extension  .BRN. 
  
Save Parameters As 
 
This command will save the set up parameters to a parameters file.  You will be prompted to supply a file name.  
Parameters files have the extension .BRN. 
 
Create DMC File As 
 
This command will save the set up parameters to a DMC file.  That is, all the parameters will be saved as a series of DMC 
commands which can be sent to the controller at any time.  You will be prompted to supply a file name.  DMC files have 
the extension .DMC. 
 
Print 
 
The print command will print the current display. 
 
Exit 
 
This command will exit the current form and return you to the main form.  If you are already on the main form, this 
command will exit the Servo Design Kit. 
 
 
Get Parameters 
 



20  ••   Chapter 7 - System Information Windows Servo Design Kit WSDK 

This command will retrieve all the set up parameters from the controller.  This command is executed automatically when 
the Set Up and Configuration form is first displayed, and after the Reset Controller and Master Reset Controller 
commands have been executed. 
 
Set Parameters 
 
This command will send all the set up parameters displayed on the screen to the controller and then will execute the burn 
(BN) command to save the set up parameters in the non-volatile memory (EEPROM) of the controller. 
 
Clear 
 
This command clears the set up parameters display.  To view the current set up parameters, use the Get Parameters 
command. 
 
Reset Controller 
 
The reset controller command resets the state of the controller to its power-on condition.  The previously saved state of 
the controller, along with the set up parameter values and saved sequences are restored. 
 
Master Reset Controller 
 
The master reset command resets the set up parameters of the controller to the factory default settings and erases the 
non-volatile memory (EEPROM). 
 



Windows Servo Design Kit WSDK Chapter 8 - Terminal and Program Editor  ••   21 

Chapter 8 - Terminal and Program 
Editor 

Included in the WSDK program is a terminal screen used to send commands to the controller and display any response.  
This tool provides a direct link to the system- allowing simple programming and status interrogation.  To open the 
terminal select the “Storage Scope” button from the main menu then the “Terminal” button from the storage scope screen.   

 
 
Functions available in the terminal include a status polling windows located under the “Motion Status” menu, sending a 
master reset under the “Options” menu and viewing the version of the controllers firmware by selecting the “Version” 
button. 

Program Editor 
To bring up the editor select the “Editor” button or type “ED” in the command line section of the terminal.  This brings up 
a simple text editor best suited for smaller programs ( under 500 lines ). 
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Once a program is created it can be downloaded to the controller using the “Download” selection under the “File” menu.  
Likewise a file existing in the controller can be displayed by selecting “Upload File” from the same menu.  Hitting the 
escape button on the keyboard will remove the editor from view, but the text information is not lost until WSDK is shut 
down. 
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Glossary of Terms 
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